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Setting Up Mosaic for Windows on Your System

Setting Up Mosaic for Windows
on Your System

After you have obtained all the files you need to run Mosaic for Windows on
your PC, you can go through the process of getting the software ready to run.
This section covers the steps necessary to set up the basic Mosaic for Win-
dows software, gives an example of setting up SL/IP software to connect your
personal computer to the Internet, and discusses how to set up any auxiliary
software you have retrieved to use with Mosaic.

Setting Up the Basic Mosaic Software

Setting up the basic Mosaic for Windows software consists of unpacking and
installing the Windows 32-bit libraries and the Mosaic software itself. The
first step is to install the Windows 32-bit libraries into your Microsoft Win-
dows directories.

Installing the Windows 32-bit Libraries

The Windows 32-bit libraries, written by Microsoft, come with the standard
Windows setup utility to do the installation. This makes the process of in-
stalling these libraries simple and almost foolproof. The following are the
steps necessary to install these libraries:
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Setting Up Mosaic for Windows on Your System 59

software—it allows you to make sure that the 32-bit libraries are run-
ning correctly.

10. After setup is complete select Exit to leave the program. The 32-bit
libraries should be completely loaded.

11. You can remove the files in the temporary directory, as they are no
longer needed.

This completes the process of loading the Windows 32-bit library software.
You can now proceed with loading the Mosaic for Windows software.

If you have a LaserMaster printer or printer accessory you may have a little
work to do before you can install Win32s. For years, LaserMaster has used the
term Winspool for their printer ports. For example, if you have a WinJet800—
a modification that makes a Laser]et III print at 800 dots per inch—you have
a print driver that is named LM Winjet 800 PS on WINSPOOL. The term
WINSPOOL, then, is a protected one—after you've started Windows you
cannot create a file called WINSPOOL, in the same way that you cannot cre-
ate a file in DOS called LPT1 or COM1.

Unfortunately, Microsoft picked the name WINSPOOL.DRYV for one of the
Win32s files. So if you have installed a LaserMaster product, when you try to
install your Win32s system, the setup program locks up when it tries to copy
and extract the WINSPOOL.DR_ file off the disk.
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That's if you have the Win32s files on a disk—if you are getting the ZIP file
off the Internet and are trying to extract the archived files out of the ZIP file,
you won't even be able to get as far as the installation procedure. You'll be
able to extract all of the files out of the ZIP file except for one—
WINSPOOL.DR _.

Luckily, the fix is fairly easy. Just follow these steps:

1. At the File Manager or Program Manager, open the File menu and
choose Run. Type sysedit and press Enter. The Windows System Con-
figuration Editor appears. This contains several document windows, one
of which contains the SYSTEM.INI file.

2. Maximize the SYSTEM.INI document window.

3. In the SYSTEM.INI file, find these lines:

device=LMHAROLD.386
device=LMCAP.386
device=LMMI.386
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Setting Up Mosaic for Windows on Your System 61

Now you have to create a new program item. Select the program group
where you want to put Mosaic. To create a new program item, open the
File menu and choose New. In the New Program Object dialog box that
appears, select Program Item, then select OK. In the Program Item Prop-
erties dialog, select Browse; select the Mosaic EXE file in the browser;
then select OK (or double-click the EXE file). This fills in the Command
Line: field of the Program Item Properties dialog box. You can now
select OK in this dialog box. The Mosaic icon appears in the program

group.
6. The setup of the Mosaic for Windows software is now complete. You Tip
can remove the Mosaic ZIP file if you want—it is no longer needed. When you create
the Mosaic pro-

While there are some customizations that can be done to the Mosaic for gram item, the
Windows software to personalize it to your needs, you can run the Mosaic Program Manager
software without any further work. You will, of course, need to set up your uses the icon that
software to connect to the Internet before using Mosaic for Windows. is built into Mo-

saic, unless you
specify a different
icon.
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Installing Viewers ‘

You can run Mosaic without installing any additional viewers or configuring
Mosaic to use them. But you may want to install these so you can view im-
ages, watch movies, and listen to sounds that you download through Mosaic.
In general, to install a viewer for Mosaic, you only need to load the viewer
program onto your local disk, then tell Mosaic where it is located, and what
type of files you can view with it. To set up Mosaic to use a viewer, follow

these steps:

1. If you haven't already downloaded the files for the viewers you need,
consult the section “Multimedia Viewers” earlier in this chapter, to find
the viewer you need, then use FIP to transfer it.
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Using the Mosaic Interface

image/gif="c:\mosaic\lview\lview31 %ls"

where image/gif is the type of file and file extension,
c:\mosaic\lview\lview31 is the path and file name for your viewer,
and s1s ends every entry.

9. Save the file and exit the text editor. (If you are using an editor other
than Notepad, be sure to save as text only.)

You can make additional changes to installed viewers in this section at any
time.

Using the Mosaic Interface

After you have installed all of the software that you need to run Mosaic, you
can connect to your Internet provider and start Mosaic. Mosaic is a very pow-
erful application, but it is graphically oriented and not difficult to use after
you are familiar with all of its features.

Starting Mosaic

Before starting Mosaic, you should first be connected to the Internet. If your
Internet connection is via your LAN, be sure you are logged onto your net-
work. If you are connected to the Internet by a modem, start your TCP/IP
software and login to your account.

After you have established your Internet connection, open the Mosaic pro-
gram group (or whatever program group you put Mosaic in), and double-click
the Mosaic icon. You are now ready to explore the Internet with Mosaic.
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Using the Mosaic Interface

the name of the application (NCSA Mosaic) and the name of the WWW
document that you are viewing.

The menu bar gives access to all of the functions you need to use Mo-
saic. You can retrieve documents to view, print documents, customize
the look of your Mosaic window, navigate between documents, anno-
tate documents, save files, and access Mosaic’s on-line help.

The URL bar shows the URL of the current document. When you open
a document, its URL is displayed, and the Mosaic logo on the right side
of the URL bar spins while the document is being retrieved.

The document viewing area is the area of the window where you see the
text of a document and any inline images it may contain.

The status bar serves two functions. While Mosaic is loading your docu-
ment, it shows the progress of the different files that are being loaded.
When you are viewing a document, it shows the URL of the hyperlink
that is under your cursor. The three boxes at the right of the status bar
show the state of your Caps Lock, Num Lock, and Scroll Lock keys on
your keyboard.

The tool bar gives you quick access to some of the most used features in
Mosaic (see fig. 3.6).

Back Paste Print

Fig. 3.6

toolbar.
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Chapter 4

Getting Mosaic fq
Running

Before you can surf the net with Mosaic on your Macintosh, your Mac must
be connected to the Internet and have the relevant software loaded.

In this chapter, you learn to do the following:
M Assess your computer to see if it can handle Mosaic for Macintosh
B Obtain a copy of Mosaic for Macintosh and its auxiliary viewers

B Install and configure Mosaic and its viewers
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B Recognize the Mosaic for Macintosh interface and interact with it

Can Your Computer System Run
Mosaic for Macintosh?

Before you attempt to load and run Mosaic for Macintosh, you must deter-
mine whether your personal computer has adequate resources for the job.
Mosaic is a fairly hefty application; it will test your system’s capabilities.

Basic System Requirements

The Macintosh product line is quite consistent across all models, so in gen-
eral Mosaic will run on any Mac with System 7. You may, however, experi-
ence dilemmas with a Mac Plus keyboard, as it lacks a Control key.

To run Mosaic, your computer needs adequate main memory (RAM). Most
Macintoshes have at least 4M RAM. Most systems are usually 1IM-3M
and because Mosaic needs 3M and also transparently launches auxiliary
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Where to Get Mosaic for Macintosh and Associated Software 69

Where to Get Mosaic for Macintosh
and Associated Software

All the software necessary to run Mosaic is public domain, freeware, or
shareware written by universities, companies, or individuals. The following
sections discuss where you can find and download this software.

Obtaining Network Software

If you are on an Ethernet LAN, you probably already have a TCP/IP stack and
a system administrator. If you are not on an Ethernet LAN, you have to set up
your standalone Mac with a SLIP or PPP connection. Though it is assumed in
this book that you have already solved this issue, here is a recap of the ele-
ments you need:

B SLIP or PPP software, which can be obtained by downloading from the
net, by buying an Internet beginner’s book that includes a disk, or by
buying a commercial communications package (such as Symantec’s
VersaTilities).

B MacTCP, the only TCP/IP stack for the Mac, available from Apple (sepa-
rately and now bundled, starting with System 7.5) or included with the
books or commercial packages mentioned previously.

B A high speed modem—V.32 9600 bps or above.

B A provider, such as Netcom or Panix.
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The next sections discuss where on the Internet you can find Mosaic and its
helper applications, exactly which helper applications to look for, and what
versions are the latest. '

Where to Get Mosaic Software

You can download Mosaic software from the Internet. If you haven’t down-
loaded from the Internet, don’t panic—there’s a first time for everything. The
process is painless. Use the Internet’s File Transfer Protocol, or FTP, to access
public access sites (called anonymous because that’s the guest login name)
where public domain, freeware, or shareware archives of Macintosh software
reside.

Be aware that the software in these archives is work in progress, and unlike
infrequent upgrades of commercial software, new versions come out weekly
or monthly rather than yearly. The current versions at the time of writing
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Where to Get Mosaic for Macintosh and Associated Software 71
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Next, use Anarchie to select and download Mosaic from an Info-Mac mirror
(see fig. 4.2).
ra— - " o -
% File Edit Window 2 4 Fig. 4.2 H
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Setting Up Mosaic for Macintosh on Your System 73

B GhostScript is a PostScript on-line viewer. Because GhostScript is so
large and used infrequently, feel free to come back for it later.

W JPEGView, Sparkle, and GIFConverter handle graphics. GIFConverter is
shareware, for which the author requests voluntary payment.

B Sound Machine handles sound files.

B You'll see a PowerPC version of Mosaic next to the one mentioned in
table 4.1, named ncsa-mosaic-20a8-ppc.hgx.

B An upgrade patch from earlier versions of MacTCP to the latest, 2.0.4, is
also available as Communications/tcp/mactcp-20x-to-204-
updt.hqx.

Mosaic also uses some programs you probably already have local to your
Macintosh as helper applications, such as TeachText, Microsoft Word, and
Simple Player (the latter bundled with QuickTime from Apple).

Setting Up Mosaic for Macintosh on
Your System

Mosaic and its viewers install in the normal Macintosh fashion; if you are
familiar with this process, you can safely skim or skip this section.
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First, here are some general Macintosh housekeeping procedures we like to
follow:

B Place the application(s) you are installing in a top-level folder called
Applications.

W For any application that you launch often, consider making it an Apple
menu item. Consult your Mac manual for the specifics, but here’s a
quick lesson: click the application once, open the File menu and choose
Make Alias, and place the resulting alias in System:Apple Menu Items.

If you followed these suggestions and if you used Anarchie and Info-Mac sites
to retrieve the files, you can now install Mosaic and its helper applications.

For each application you downloaded, Anarchie has left three files on your
Desktop. The first file is the actual downloaded file, ending with the file
name extension HQX. This is an ASCII-encoded or BinHexed file; it just
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Using the Mosaic Interface 75

Now double-click the Mosaic icon to launch it (or, if you have created an
Apple menu item for it, select the Mosaic icon).

The Mosaic Interface
This section explains the basics of Mosaic’s user interface—what it looks like
and what you can do with it.

The Document Window

The first screen you see is the NCSA Mosaic Home Page (see fig. 4.3). This
section explains the document window first, and then explains the menus
and buttons.

Fig. 4.3
Mosaic’s default
home page.
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Notice that some text is highlighted; if you have a color monitor, this text
also is blue. These highlighted phrases are the hyperlinks; click one and it
branches to another page or screen. If you choose to backtrack to a previous
screen, you will see that any branches already explored are red.

Also, notice the little square icons. These are links to either graphics or sound
files, the multimedia part of Mosaic. Click them and a picture expands or
sounds play. Compare figures 4.3 and 4.4; figure 4.4 shows the expanded
graphic from figure 4.3.
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From Here... 77

Next, find the NCSA logo (an icon that resembles an uppercase S); it spins to
show downloading activity. To the right of the S are five tool icons that pro-
vide shortcuts for moving forward or for moving backward a page, for return-
ing to the home page, for reloading the current screen, and for saving a
screen to a local file.

To the right of the five icons is the history list. If you click and hold the
down arrow, a stack of the pages you’ve visited displays; you can use the
mouse to select one and jump back to it immediately.

Open the Options pull-down menu and choose the first item, Show URLs. A
new window appears below the line of items. It's called the URL bar, and
shows the URL of the web page you are currently viewing. It’s up to you
whether to leave the URL bar showing (you can hide it by toggling Show
URLSs), though typing in new URL descriptions here is a bit faster than using
Open URL in the File menu.

Look at the last display item, the status bar, located below the URL bar. Infor-
mative messages (good and bad) are displayed here. As you pass the mouse
arrow over highlighted text, the hyperlink of that text is displayed. When
you choose to explore a hyperlink by clicking it, the status window either
says the link is being downloaded or that an error occurred.
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From Here...

Now you're ready to explore. Use the following chapters as your guide:

soIse

B Chapter 5, “Navigating with Mosaic,” teaches you more about manipu-
lating Mosaic.

B Chapter 6, “Shortcuts to Favorite Places,” shows you advanced Mosaic
tricks.

B Chapter 13, “Hot Home Pages,” points you to the best of WWW home
pages.
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Chapter 5
Navigating with
Mosaic

The World Wide Web is one of the best examples of cyberspace. This system of
linking documents together so that you can move between them with little
effort lets you travel to many different places, literally, around the world,
learning about any topic you can imagine. But, like any traveler in a new
place, you can easily get lost.

Mosaic is an easy-to-use interface that lets you travel the WWW. It has many
convenient features to allow you to keep track of where you’ve been and get
to places quickly. This chapter assumes that you have read the section,
“Using the Mosaic Interface” at the end of chapter 3, “Getting Mosaic for
Windows Running,” and are familiar with the Mosaic concepts discussed in
chapter 2, “Introduction to the World Wide Web.”
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In this chapter, you learn to do the following:

W Start up Mosaic
W Use Mosaic’s basic features
B Navigate between documents

B Handle errors you may encounter

What Is a Home Page?

The designers of Mosaic define a home page (or home document) as the docu-
ment that you tell Mosaic to display when it starts up. This document should
contain links to the documents and WWW sites that you use most fre-
quently. Many people mistakenly use the term home page for the welcome
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Telling Mosaic What Home Page to Load 81

Fig. 5.1
Changing the
home page on a
Mac in the
Preferences dialog
box.

You can also tell Mosaic not to load any page when it starts up. To do this,
edit your MOSAIC.INI file. In the Main section of the file, set the following:

Autoload Home Page=no

Mosaic starts up with a blank display, and you can begin your navigation of
the WWW from there.
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Moving between Documents 83

Moving Backward and Forward

Typing long URLSs and scrolling through documents to look for the links you
want gets rather tedious. If you're jumping between a number of documents,
take advantage of three helpful navigating commands: Back, Forward, and
Reload.

Mosaic keeps information about what documents you have loaded (see a
discussion of the history list in chapter 6), and lets you move quickly be-
tween these documents using the Back and Forward commands. The Back
command takes you to the previous document that you had open. To go
back, open the Navigate menu and choose Back.

The next of these commands is Forward. The thing you have to remember
about Forward is that you can only move forward after moving back. (This
concept is rather confusing, but makes more sense when you have read about
history lists in chapter 6). To move forward, open the Navigate menu and
choose Forward.

The last command is Reload. This command again displays the document
that you are currently viewing. To reload the current document, open the
Navigate menu and choose Reload.

Fig. 5.2

The Windows
Mosaic home page,
with hyperlinks
identified.

Hyperlinks
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Moving between Documents 85

Fig. 5.4

The Open URL
dialog box on a
Mac.

3. If you want to enter a completely new URL, just begin typing the URL
in the box and the old contents are deleted. If you want to modify the
URL that is shown, click the box again and your cursor is inserted in the
text, where you can edit the current URL.

4. Choose OK (Open on the Mac) to load the URL that you entered, or
choose Cancel if you do not want to load that document. If you choose
OK, Mosaic loads that document and displays the URL for the docu-
ment in the URL bar (if you have it enabled).
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What You See When a Document Is Loaded

When you load a document, Mosaic gives you a lot of information about
what is happening. The globe in the URL bar rotates, with its beacon flashing.
A number of different messages appear in the status bar. These messages can
include:

B Doing nameserver lookup on:<hostname>

B Connecting to HTTP server (If it is another type of server, such as Go-
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Moving between Documents

Looking for Information in a Document

If the WWW document you are reading is short, it is easy to scroll through
the document (or use Page Up and Page Down) to find information of inter-
est to you. If you have loaded a very long document, though, Mosaic does
provide a way to look for information. Follow these steps:

1. Open the Edit menu and choose Find to bring up the Find window.

2. Click the box next to Find What: and enter the word for which you
want to search.

3. Click Match Case if you want Mosaic to match exactly the capitaliza-
tion of the word you entered.

4. Choose Find Next to begin the search. If a match is found, Mosaic
scrolls the window to the section where the match is. An alert box in-
forms you if no match is found.

The Find feature does not work properly in the Windows version of Mosaic. It does
not always find matching words when they do exist, and does not always notify you
when no matches are found. Sometimes, the find feature causes your PC to lock up,
requiring you to reboot your computer. This is a known bug.

Saving and Printing Documents

In general, the purpose of the WWW is to be able to have one copy of a docu-
ment that many people can view, although there are times when you might
want to save a copy of a document to your local computer. Mosaic gives you
several options for saving files.

On both the Macintosh and Windows versions of Mosaic, you can open the
File menu and choose Save As (this feature did not work in the 2.0a6 Win-
dows version, but is working in the 2.0a7 version). This brings up a Save As
dialog box that lets you browse through your directories and store the file
wherever you like.
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Customizing Your Mosaic Window

Customizing Your Mosaic Window

This chapter has covered some of the features of Mosaic that let you move
between documents. You can customize a number of these features; you can
set up Mosaic to behave in a way that is most comfortable for you. This sec-
tion discusses how to set up Mosaic to your preferences.

Customizing the Hyperlink Indicators in Windows
You can change the default appearance and color of the hyperlinks in the
documents Mosaic loads. To do so, edit the MOSAIC.INI file and set the fol-
lowing lines:

[Main]

Anchor Underline=no

Anchor Cursor=yes

[Settings]

Anchor Color=0,0,255
Setting Anchor Underline to No turns off the anchor underlining in docu-
ments (this feature does not work and is a reported bug in the 2.0 alpha 6
release of Mosaic, and does not appear to have been fixed in the 2.0 alpha 8
release). Setting Anchor Cursor to Yes enables the Anchor Color variable. The
Anchor Color variable takes values from O to 255 for red, green, and blue
components to create the hyperlink identifying color (this feature also ap-
pears to be broken, although it is not a listed bug).

You can set your cursor so that it does not change shape when you are over a
hyperlink. Open the Options menu, and select Change Cursor Over Anchors
(it's off when the check mark disappears). If this option is on, your cursor will
change (by default, to a pointing hand) when it is over a link.

Customizing the Hyperlink Indicators and

Background Colors on a Mac

Changing the colors used for explored and unexplored links is quite straight- rf;ﬂ
forward on the Macintosh. -

| —
——

1. Open the Options menu and choose Preferences.

2. In the Preferences dialog box, choose Links from the strip of buttons on
the left side. You see a variety of possible link items: the top right are
the explored and unexplored color choices (see fig. 5.5).

3. If you click one of the color boxes, you get a color wheel from which
you can choose your favorite colors (see fig. 5.6).
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Customizing Your Mosaic Window 91

Fig. 5.7

You can also set
the color of your
Mosaic window
background in the
Preferences dialog
box.

Fig. 5.8

The color wheel
dialog box gives
you a wide range
of colors to choose
from for your
background color.

Tent Color

Hue |0

Saturation [0
Brightness |56797

Red {56797
Green |96797
Blue (36797

EOE P

4. Click on the color you want. The color in the box on the left of the
dialog box should reflect your choice.

5. Click OK and then Apply and you’re finished.

Customizing the Displayed Fonts in Windows

You can customize the fonts that Mosaic uses when displaying documents.
HTML documents use standard paragraph tags to describe each paragraph in
the document. Mosaic lets you specify the font family, size, and style for each
of the standard HTML paragraph tags.

1. Open the Options menu, and choose Font. A walking menu appears
that lists the different HTML paragraph tags.

2. From this walking menu, select the paragraph tag of the font you want
to change. Even if you aren’t familiar with HTML, you can guess what
the different paragraph types are. For example, Normal is the regular
text font, Heading] is usually the large heading at the top of a docu-
ment, and so on.
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Customizing Your Mosaic Window 93

fill in the appropriate fields. If you want to these changes to apply to every
font in the document, click Apply. If you change your mind, click Cancel.

Fig. 5.10

The Style Window
dialog box lets you
change the font
attributes of entire
documents,
paragraphs types,
characters types, or
tables.

More likely than not, however, you want to modify specific paragraph tags,
not an entire document. To modify individual tags, follow these steps:

1. Click the paragraph icon on the left side of the Style Window dialog
box. Now you see the possible settings have changed to those shown in
figure 5.11. The key item here is the top left box called HTML style.

Fig. 5.11

The Paragraph
option in the Style
Window dialog
box lets you
change the font
characteristics of
each HTML
paragraph tag.

=
Q
s
-
(o)
w

s3ise

2. Click any of about a dozen different paragraph tags in a document,
then modify it to your preferences (see fig. 5.12). To modify a paragraph
tag, choose it from the HTML style box.

3. After you select the paragraph tag to modify, set the parameters to your
liking for any of the characteristics (font family, size, style, color or
spacing), and choose Apply. If you decide that you don’t want to
modify the paragraph tag, choose Cancel.
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from the list of HTML Styles, change the parameters to your specifications,
and choose Apply (or Cancel if you change your mind).

Customizing the Window Areas

Many of the different window areas in Mosaic are optional (not, however, the
document viewing area—Mosaic wouldn'’t be very useful without that!). The
title bar and menu bar cannot be removed, but the tool bar, URL bar, and
status bar can all be turned off. Turning these window areas off gives you a
bigger viewing area, but removes some timesaving and informational fea-
tures.

B To turn off the tool bar, open the Options menu and click Show
Toolbar. The check mark next to the menu item disappears and the
tool bar is removed from the window. (This option isn’t available on a
Mac.)

B To turn off the URL bar, open the Options menu and click Show Cur-
rent URL. The check mark next to the menu item disappears and the
URL bar is removed from the window. (Note that this also removes the
globe; you can no longer click the globe to interrupt a command.)

B To turn off the status bar, open the Options menu and click Show Sta-
tus Bar. The check mark next to the menu item disappears and the sta-
tus bar is removed from the window.

Fig. 5.14

The Styles Window
dialog box lets you
modify the font
characteristics of
HTML table tags.

<« See “Using the
Mosaic Inter-
face,” p. 63

g
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| dal.gil; 504xB26X64 - | View 31 . ’ Fig. 5.15
File Edit Retouch Opticns Help b : When Mosaic
loads a file type
that it recognizes,
the viewer you
specify for that file
type displays the *
image, sound,
animation, and so

OI.
Notice that because the image is loaded in an external application, you can
use Mosaic at the same time you view the image. 2
o
v
Temporary Files on the Mac 2
The Mac version of Mosaic uses temporary files to store downloaded multi- (Tj g
media files while the download is in progress and while you are viewing the { - J ‘ﬁ.
 w— w

files. Several commands and options relate to these temporary files.

When Mosaic loads files that need an external viewer, it temporarily stores
the files in the System Folder before launching the viewer. Although Mosaic
deletes these files when you exit the application, you may want to set up a
separate temporary file to keep your System Folder from becoming cluttered.

To tell Mosaic to use a temporary folder instead of storing temporary files in
the System Folder, open the Options menu and select Use Mac Temporary
Folder. When this option is selected, by default, Mosaic stores the temporary
files in an invisible folder called Temporary Items on the top level of your
system disk.

At one time, the invisible Temporary Items file occasionally disappeared and caused

an error when an external viewer attempted to access this file. The authors could not
verify whether this bug was fixed in the latest release of Mac Mosaic.
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Working with Local Files 99

Fig. 5.17

The Open dialog
box enables you to
enter a local file
name or to browse
your local file

3 stddac system to find the
next document
that you want to
view.

Creating Your Personal Home Page

Creating your own home page is simple. HTML comprises special codes,
placed between < > symbols, that tell a Web browser what each piece of text
is.

To create a home page, first open a text editor, or a word processor that lets
you save your work in ASCII format. At the top of the page, type the docu-
ment title. The title doesn’t appear in the document when it is displayed in a
browser, but is used as an identifier. Mosaic displays the title in the window’s
title bar.

Below the title, type the first heading you want to appear in the document.
This heading appears at the top of the page. Then type a line or two of text.
Below those lines, type another header then type the name of a document to
which you want to link your home page. For example:

Personal Home Page

Personal Home Page

This is my very own home page.

Very Important Links

The Simpsons
In this example, Personal Home Page is the document title and the first head-
ing. Next is a line of normal text (This is my very own home page), followed
by another heading (very Important Links). The Simpsons is the first link.

Next enter the HTML codes. The codes for the title are <TITLE> and </TITLE>,
and placed as in this example:

<TITLE>Personal Home Page</TITLE>
The codes for a first heading are <H1> and </H1>. These codes are before and

after the text in the same way as the preceding example. The body text
doesn’t need any code preceding it; browsers assume that if text has no code
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Problems That Occur While Navigating the WWW 101

OK button at the bottom of the window, or open the File menu and choose
Exit. Figure 5.18 shows a document loaded into Mosaic and its corresponding
HTML code.

Fig. 5.18

The Document
Source window
enables you to
scroll through the

source file for the
his iz a primer for producing documents in HTML, the markup language
used by the World Wide Web. current document

UL and see what
<Li><A HREF="#A1.1">Acronym Expansion</A>
LI><A HREF="HA1.2">What This Primer Doesn't Coverc/A» HTML commands
LI><A HREF="§A1.3">Creating HTML D tac/AY
PATIA teating acuments were used to create
<LI><A HREF="]1A1.3.1"> The Minimal HTML D ocument</A>
<LI><A HREF="A1.3.2"> Basic Markup Tags</A> the document.
<UL>»
<LI><A HREF="H1A1.3.2.1"> Titles</A>
<Li><A HREF="ftA1.3.2.2">Headings</A> -
<LI><A HREF="ftA1.3.2.3"> Paragraphs</A>
U
<LI><A HREF="1A1.3.3" Linking to Dther Documents</A>
u

1.3.3.1">Relative Links Yersus Absolute Pathnames«</A>
1.3, ")Umlm‘m Resource Locator</A>
to Specific Secti in Other D

In the Document Source window, you can highlight and copy text to the
Clipboard. Open the Edit menu and choose Copy. To save the entire source
for this document to your local disk, open the File menu in the Document
Source window and choose Save. The Save As dialog box appears, letting you
save the HTML source in a file anywhere on your local file system.

To close this window, click the OK button at the bottom of the window, or
open the File menu and choose Exit.

Another way to save the HTML source of a document is to open the Options
menu and choose Load to Disk, then click on a link to the document. This
brings up the Save As dialog box, which lets you save the HTML source for
the document anywhere on your local file system.

Problems That Occur While
Navigating the WWW

The World Wide Web is really a concept still under development, and Mosaic
is definitely an application still under development. For an alpha release, it
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Problems That Occur While Navigating the WwwW 103

H Enter an invalid protocol. Windows Mosaic gives you an Access
not available error alert like the one shown in figure 5.19. Choose OK
to make the alert disappear, and then try to load a valid URL. (Mac
Mosaic gives an Unable to Access Document €Iror.)

H Try to load a document that doesn’t exist. You get a File/direc-
tory does not exist error alert. Choose OK to make the alert disap-
pear, and then try to load a valid URL. (Mac Mosaic gives you a Not
Found error.)

B Try to load from a site that doesn’t exist. You get a Failed DNS
Lookup error alert. Choose OK to make the alert disappear, and then try
to load a valid URL. (Mac Mosaic gives you an Unable to connect to
remote host eIror.)

Network Errors

A number of network-related errors can be caused by a machine being down,
too much traffic on the network, too many people using a host’s resources, or
any number of other problems. These types of problems are associated with
having a large number of different types of machines and services on a large
network.

The following list of error alerts is by no means exhaustive, but shows some
of the most common errors. If you load the Bug List document from the Win-
dows Mosaic Help menu and scroll down to the bottom, you see the link
Common Error Messages in a section entitled “Bug Like Features.” This link
loads a document (http://www.ncsa.uiuc.edu/SDG/Software/
WinMosaic/errors.html) that lists most of the errors that you can see (but
it doesn't tell you what caused them or how to avoid them). These errors can
occur with Macintosh Mosaic, also, but they are reported slightly differently.

W SOCKET:Connection has been refused. This error usually occurs because
the maximum number of people allowed to use the host’s resources are
currently on-line. Try again later.

Fig. 5.19

When Mosaic
encounters an
error, it usually
brings up an alert
box like this one
to let you know
what happened.
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Chapter 6

Shortcuts to Favo
Places

The WWW lets you move easily between documents. Although this is conve-
nient, it also can be a curse. While moving back and forth, you easily can get
lost—and URLs can be long, complicated, and difficult to remember.

Mosaic has many features that allow you to keep track of where you were and
allow you to get to places quickly. This chapter assumes you have read chap-
ter 5, “Navigating with Mosaic.”

In this chapter, you learn to do the following:

=)
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B Navigate the WWW efficiently
B Keep track of sites that interest you

B Quickly access the sites you use the most

Effective Browsing Techniques

Navigating between WWW documents can be confusing. Documents often
connect back to documents you already read. You don’t know you're going to
a document you've already seen because different words or pictures are used
for the hyperlink than the ones you used originally.

Sometimes you can’t tell from the hyperlink whether the document is of
interest to you—loading documents uses valuable time. Often, you waste
time loading documents that you dismiss immediately. This section helps
you learn to reduce unnecessary document loading and circular navigating.
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Effective Browsing Techniques 107

How to Get Where You Were

Trying to navigate back to a document you viewed in the current Mosaic
session also can be challenging. In general, to go to the document you
viewed prior to the current document, open the Navigate menu and choose
the Back command (or the left arrow in the toolbar). Choosing the Forward
command (or the tight arrow) takes you to the last document you viewed
after this document. This sounds rather confusing, but is understandable if
you look at how Mosaic determines these links.

The Navigate menu has an item called History that brings up a window,
similar to the one shown in figure 6.2. Notice, there is a list of URLs in
this window—the URL for the current document is highlighted.

NCSA Mnsdic - History Fig_ 6.2
ot 33:',“,.::,‘?.,..,. The NCSA Mosaic
History window
shows a linear list
of URLs you visit.
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The history list shows you the URLs of the document chain that led you to
this point and any documents that you visited after the current document.
If you use the Back navigation command, you move up the list. If you use
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Effective Browsing Techniques 109

very useful if you can’t remember all the sites and don’t want to waste time
reloading a document that you already saw.

By default, the sites in the global history list are shown in red (as opposed to
blue for unexplored sites). You can change the color for these previously
explored sites. The global history list doesn’t extend back in time indefinitely.
By default, Mosaic keeps an item on the list for only 20 days. After that, it is
removed from the list and appears in blue as an unexplored site. You can
change this default, too, to suit your needs. You can also set a limit on the
number of items tracked on the global hotlist. (Use this option or remove
items after a given number of days.)

To change the color of explored sites, to change the length of time an item <« See “Custom-
remains on the global history list, or to set a limit on the number of items on izing the
Hyperlink

the list, follow these steps:
Indicators on a

To change colors, open the Options menu and choose Preferences. In the Mac,” p. 89
Preferences dialog box, choose the Links item from the strip of buttons on

the left side. You'll see a variety of possible link items (see fig. 6.4): the top

right are the explored and unexplored color choices. If you click one of the

color boxes, you get a color wheel from which you can choose your favorite

colors (see fig. 6.5). Click OK and then click Apply.

The Links Preference dialog box also lets you change the length of time an
item can remain on the global history list or how long the list can be (see

fig. 6.4). Click the small radio button to the left of the explanatory phrase for
the item that you want to set. After you’ve done that, the radio button will
darken, and you can now click the entry field for that item and type in any
value. The default values are 20 days for global history, and a maximum list -
size of 10 entries.

Fig. 6.4

~ The Links
Preferences dialog
box lets you set up
how long an item
remains in your
global history list
and the maximum
length of the list.
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Create Lists of Your Favorite URLs 111

The Personal Menus dialog box allows you to add, delete, and edit Mosaic
menus. To open the Personal Menus dialog box, open the Navigate menu and
choose Menu Editor (see fig. 6.6).

Fig. 6.6
The Mosaic
-Starting Points Personal Menus
World Wide Web Info .
-Home Pages dlalOg box shows
-Gopher Servers
current menus

-Other Documents

and items on
those menus, and
lets you create,
delete, and edit
these menus.

The existing user-configurable menus are shown in the Menus section of the
dialog box. If you click a menu in this list, the items from that menu are
displayed in the Items section. When you're finished modifying your per-
sonal menus, click Close to close the dialog box.
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Create Lists of Your Favorite URLs 113

3. Click the box next to Title and enter the name of the menu you want to
add. Notice that the Menu radio button is checked automatically—you
can’t deselect it or select another radio button.

4. Click Close. The new menu appears highlighted in the Menus section of
the Personal Menus dialog box. You are now ready to add items to the
menu.

Tip

If you have a
SuperVGA moni-
tor, use Windows
setup to choose a
driver for a higher
screen resolution
(800 x 600) to get
more menu items
Adding Items to a Menu on-screen.

After you create a new menu, you can add the items you want to appear in

the menu—you can also add items to any existing menu. Mosaic currently

has a limit of 40 items per menu.

To add items to a menu, follow these steps:

1. Open the Navigate menu and choose Menu Editor to open the Personal
Menus dialog box.
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2. In the Menus section of the dialog box, click the name of the menu to
which you want to add items.

3. If there are existing items in that menu, you can place the new item
anywhere in the list. If you click the name of an item in the Items sec-
tion, the new item is added before the selected one. If you do not select
one of the current items, the new item is added to the end of the list.

4. When you have selected the menu and item position, choose Insert.
The Add Item dialog box appears (see fig. 6.10).

Fig. 6.10

In the Add Item
dialog box, enter

the name of the
menu item you are
adding and the URL
associated with it, if
there is one. You can
also identify the type
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Adding a Submenu. Another way to group related items in your menus is to
create a submenu that contains the related items. Remember, Mosaic has a
limit of 20 user-configurable menus and submenus.

To create a submenu, follow these steps:

1. In the Add Item dialog box, select the Menu radio button. The fields
that pertain to this item type become active, as shown in figure 6.12.

Fig. 6.12

When you select
the Menu radio
button, only the
Title field is active.

2. Click the box next to Title and enter the name you want to appear in
the menu.

3. Choose OK. The item appears in the [tems section of the Personal Menu
dialog box. Note that it has a right angle bracket next to it to indicate
that it’s a menu.

Adding a Separator. If you don’t want to add any submenus, but still want
to group some of your menu entries, you can visually group items in a menu
by putting a thin line called a separator between groups of related items.
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To add a separator, follow these steps:

1. In the Add Item dialog box, select the Separator radio button. No active
entry fields are in the Add Item dialog box (see fig. 6.13).

Fig. 6.13

When you click
the Separator radio
button, all entry
fields become
inactive; you do
not need to enter

2. Choose OK. A line appears in the Items section of the Personal Menu any information
dialog box. for this type of
item.
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Quick Access to Your Favorite URLs 117

If you are deleting an item, it is removed. If you are deleting a menu, you are
asked if you want to recursively delete the menu—meaning it deletes every-
thing under the menu. Choose OK; it is confusing to delete a menu, but not
to delete items on that menu.

One of the problems with the 2.0 alpha 6 release of Mosaic involves deleting
submenus. Mosaic asks if you are sure you want to delete the submenu, but if you try
to cancel the request, the submenu is still deleted. Parts of the deleted submenu may
show up when you look at a list of menus in the Current Hotlist field in the Open URL
window.

Creating Your Own QUICKLIST

The QUICKLIST is a permanent hotlist that you cannot delete—or change the
title. The QUICKLIST does not show up as a menu in the menu bar: the only
way to access it is to make it the Current Hotlist and select an item from it in
the Open URL window (this procedure is explained in more detail in the
section, “Setting and Using the Current Hotlist,” later in this chapter).

You can insert, edit, and delete items in the QUICKLIST the same way you do
for any of the other user-configurable menus—using the Personal Menus
dialog box. Unlike the other user-configurable menus, which have a limit of

2
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40 items, there is no limit to the number of items in the QUICKLIST. §
L)

Quick Access to Your Favorite URLs

Now that you have all these hotlists set up, how do you use them? You can
select items directly from the user-configurable menus, or you can select
them from the Open URL window. This saves you the trouble of having to
remember and type in long URLs.
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Personal Means Fig. 6.18
You can set the
Slartingdl:vlﬁ_r‘litsw N v menu selected. Current Hotlist
}-Iv:r:nle Pages tofo from the Personal
Goapher Servers .
-Other Documents Menus window.
2, Click in the Current Hotlist field to display a drop-down list of available
hotlists (see fig. 6.19).
Fig. 6.19

Personal Menus
You can select
Starting Paints o menu selected. any of the user-
World Wide Web Info .
-Home Pages conflgurable
-Gopher Servers
menus to be the

-Other Documents
Current Hotlist.

s
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UICKLIST
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UICKLIST

ther Documents
WWf Informatoin
testing deletion stiff
QUICKLIST

3. Click the hotlist you want to designate as the Current Hotlist.

4. Click Close to dismiss this dialog box.

139 Facebook Inc,'s Exhibit 1006
Petitioner Microsoft Corporation, Ex. 1006, p. 139



o . 140 Facebook Inc,'s Exhibit 1006
Petitioner Microsoft Corporation, Ex. 1006, p. 140



Quick Access to Your Favorite URLs 121

1. Click the menu.

2, Choose an item from the menu. If the item you choose is also a menu,
a submenu pops up, and from it you can choose an item (see fig. 6.21),

NCSA Mbsaie - {untinea] Fig. 6.21

File Edit Options Navigate Annotate | §ifafh =iie
Starting Points Document The personal
NCSA Mosaic Demo Dacument menus you create
NCSA Mosaic's 'What's New' Page allow you to
NCSA Mosaic Home Page .
Windows Mosaic home page qule-ly load URLs
Web Overview World Wide Web Info from the menu
Web Project Home Pages
Data Sources By Service Gopher Servers » bar.
Information By Subject Finger Gateway
Web News Whaois Gateway
Web Servers Directory Other Documents ¥
HTML Quick Reference Archie Request Form
NCSA Mosaic Web Index

When you release the mouse button after selecting an item, Mosaic loads the
URL for that item.

Sharing Hotlists

Sharing hotlists is a good way to make coworkers and colleagues aware

of information resources they would otherwise not know. At this time, Mo-
saic does not have an automated way of exporting and importing hotlists.
However, if you edit your MOSAIC.INI file, you find the hotlists defined after
the Annotations section in the file and at the end of the file. Entries have
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headings, such as user Menu1, followed by the name and URL for each item in
the menu. You can copy these menu definitions from your MOSAIC.INI file
into an e-mail message, or file and distribute them to people you think might
be interested in them. They can then edit their MOSAIC.INI file and insert
these menus in the file.

Using Built-In Hotlists
_ Mosaic, as distributed from NCSA, comes with two built-in hotlists: the Start-
ing Points hotlist and the QUICKLIST. You can edit both lists to suit your
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The QUICKLIST Hotlist
The built-in QUICKLIST hotlist gives you access to some of the same places as
the Starting Points hotlist. In addition, the QUICKLIST gives you:

B Quick access to your local hard disk.

M Access to on-line weather forecast information.

You may want to explore the items included with this list when you first start
using Mosaic. If they are not of any use to you, replace the items with ones
you use frequently.

Editing Mac Hotlists

You need a way to edit Hotlists on the Mac. This is done in the Hotlist Items
dialog box, the same place you select a current hotlist or open a hotlist item
(see fig. 6.22) To open this dialog box, open the Navigate menu and choose

Hotlist.

Fig. 6.22
Any change to any
hotlist can be made
in the Hotlist Items
dialog box.

9¢
ring Hotlists ¥ith Qther NCSA Mosaic Users
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To create a new Hotlist, open the Hotlist Items dialog box and click New HL. [—ﬂ
This creates a new Hotlist called Untitled Hotlist.1. There aren’t any items in =
it when you create it.

To add the open document to the current hotlist, open the Navigate menu
and choose Add This Document.

To add any document to any hotlist follow these steps:
1. Open the Hotlist Items dialog box.

2. From the drop-down list, select the hotlist to which you want to add
the item.
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Using Annotations 125

To set up the annotation information in your MOSAIC.INI file follow these
steps:

1. Edit the MOSAIC.INI with a text editor like Notepad.
2. Find the [Annotations] section of the file.

3. Change the Directory= entry to point to the directory where you want
the annotation files to be stored.

4. Change the Default Title= entry to the default title for your
annotations. ‘

5. Set Group Annotations=no.

6. Although Mosaic does not support an e-mail protocol at this time, it
lets you define a default e-mail address, and uses this address as the
default value for the Author field in the Annotations Window. To set
your e-mail address, scroll up to the top of your MOSAIC.INI file and
under the [Main] section, change the E-mail= entry to your e-mail
address,

You should now be ready to use Mosaic’s annotation feature.

Using Mosaic’s Annotation Feature
To add an annotation to a document, follow these steps:

Q
7]
S
A
o)
o
2.
A
w

1. Open the Annotate menu and choose Annotate. The Annotate
Window dialog box shown in figure 6.24 appears.

Fig. 6.24

The Annotate
Window dialog box
lets you create
annotations for
Mosaic documents.
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Adding an Audio Annotation on the Mac

The Macintosh version of Mosaic also offers audio annotations, a feature we Eﬂ
haven't seen yet in the Windows version. Like the text annotations, this just =
became functional in the 2.0a8 release. To add an audio annotation to the —

current document:
1. Be sure the microphone on your Mac is plugged in and working.

2. Open the Annotate menu and choose Audio. A dialog box opens in
which you can enter your name and a title for the annotation.

3. Click record. This will open the dialog box shown in figure 6.25.

FEEG] i il
t(] This dialog box is
Record Stop Pause Play used to record an
= M0%00 audio annotation.
4. Click the record button then speak into the microphone.
5. Click the Stop button when finished. =
=]
6. Click Save to save the annotation. 2
=
To listen to the annotation, click the link for it in the document. A new o
document opens, like the one in figure 6.26, indicating that this is an audio g_
annotation. Click where it says To hear the annotation. a
Fig. 6.26

A document
containing an
audio annotation.
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Searching Indexes and Using Forms 129

There are several other very useful Web Pages that use forms to help you

_search the Web for relevant documents. While none of these searches are
perfect, using one of them is better than randomly jumping from page to
page looking for information you might need. Here is a list with the names
and URL addresses of some of the better search pages:

B EINet Galaxy - Search the World Wide Web
http://galaxy.einet.net/www/www.html
B Webcrawler Searcher
http://www.biotech.washington.edu
or

http://www.biotech.washington.edu/WebCrawler
/WebQuery.html

B WWWW - the World Wide Web Worm

http://www.cs.colorado.edu/home/mcbryan
/WWWW.html

Fig. 6.28

The search results
are placed in a
Web document,
with links to the
items found.
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